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Introduction
TimeTracker is Shareware - you may try the program for a short time, but if you like it and want to keep 
using it, please send in the requested $20 registration fee.    A lot of time and effort went into developing 
this program, please be fair and help support it.
Please read this manual.    It is short and easy to read.
Feel free to submit comments, suggestions, and bug reports.
TimeTracker™ developed by

Maui Software
189 Auoli Drive
Makawao, Maui, HI 96768-9313
Phone: 808-573-0011
FAX: 808-572-2406
email: mauisw@aloha.net
©Copyright 1995 Maui Software.
All Rights Reserved Worldwide.

Credits
TimeTracker graphics (startup window, and about box) by

Ed Fenner
Design Mine
Boulder, CO
303.530.4365 / 800.779.2433
email: DesignMine@AOL.COM

TimeTracker program and user's manual icon graphics by
Halvor Nome
NOME A/S Design & Market Communication
Karl Johansgt. 20
N-1776 Halden.
email: nome@oslonett.no

And thanks to all the people who helped beta test TimeTracker.



Software License Agreement
Please read this agreement thoroughly.
You may use the Registered TimeTracker program on one computer system at one time only. 
If you wish to use the TimeTracker program on more than one computer system at one time, you must 
purchase a new and separate License from Maui Software for each additional computer system (each 
user must purchase their own copy).
For example, you can place the registered TimeTracker program on your office computer and also your 
home computer.    However, if you are using a registered copy of TimeTracker on your office computer, 
and someone else is using a registered copy on your home computer, you must purchase two copies of 
TimeTracker because two copies of TimeTracker are being used at the same time.      If you have any 
questions, please contact Maui Software.
You may not give the registered TimeTracker program to other people.
You may not reverse engineer, disassemble, reverse translate, or in any manner decode the 
TimeTracker program in order to derive any source code form.
COPYRIGHTS, TRADEMARK NOTICES, LEGENDS AND LOGOS. The TimeTracker program and User
Documentation, logos, product, names and other support materials, if any, are either patented, 
copyrighted, trademarked, or otherwise proprietary to Maui Software. You agree never to remove any 
such notices and product identification.
In no event will Maui Software be liable to you for any damages, including any lost profits, lost savings or
other incidental or consequential damages arising out of the use or inability to use this program and user
documentation.    In addition, Maui Software will not be liable for any claim by you or any other party for 
damages arising out of the use of this program.



How To Order TimeTracker
TimeTracker is available for only $20 per copy (one copy per user).    Quantity discounts are
available.    Contact Maui Software for more information.    Normally you receive your 
registration name and code within 24 hours.    Slow turnaround times occur during 
Christmas, holidays, vacation time, and directly after we release a new version.    
Here's how to receive your TimeTracker registration code:    

1. Start TimeTracker.    
2. On the introduction dialog box, click on the "Fill Out Order Form" button or click on 

the "Fill Out Order Form" button from the About box. (click on Help menu and then 
About menu to pop up the about box)

3. Fill out all the necessary information.
4. You can email, fax, or postal mail your order.

For fastest service -- pay by credit card and email your order:
a. From the Order Form dialog box, click on the "Save" button and save the order

form to disk.
b. Start your bulletin board program (AOL, CompuServe, etc.), and open the 

order form you just saved (select Open from the File menu to do this).
c. Make any necessary changes, add any comments, and then send it to our 

Internet address.    
For fast service -- pay by credit card and FAX your order:

a. From the Order Form dialog box, click on the "Print" button and print the order 
form.

b. Sign the form, make any necessary changes, add any comments, and FAX it to
us. (a fax cover sheet is not necessary)

For not as fast service -- use the post office:
a. From the Order Form dialog box, click on the "Print" button and print the order 

form.
b. Sign the form if you are paying by credit card, make any necessary changes, 

add any comments, enclose payment, and mail it to us. 
NOTES: 
Shipping a disk with the latest version.    If also you want a TimeTracker diskette mailed to 
you (for example, you want to receive the latest version on diskette), please enclose an 
additional $5 to cover postage and handling.    You could make out two checks (the second 
one for $5), and if there is no later version, we will return your $5 check.    Likewise for 
credit card sales.    You can authorize us to charge an additional $5 for shipping a disk if 
there is a later version.    If there is no later version, we won't charge the additional $5.    
This is at your option, and there will be no additional $5 charge unless you specify it.    
You cannot send files (attachments) to our Internet address from non-Internet services 
(although that may change in the future with some on-line services).    That's why you must
send your order form to us as an email message, and not as an attached file.    



How To Register TimeTracker
Once you have received your name and registration code, you can register your copy of 
TimeTracker.    Entering in your name and registration code changes TimeTracker from a 
demo version to a full working version registered to you.
To register TimeTracker with your registration code:

1. Start TimeTracker.
2. The Demo Version Introduction dialog box will be displayed.    Click on the "Register 

Now" button.    The Register TimeTracker dialog box will be displayed.
3. Enter your Registration Name and Registration Code exactly as given to you by Maui 

Software.
4. Click on the "Register" button.    If you receive an error, verify that the name and code

you entered is exactly as Maui Software gave to you.
NOTE:    Your name and registration code is entered in the "timetrack.ini" file automatically.  
The "timetrack.ini" file resides in the Windows directory.    If the registration information in 
this file is changed or corrupted, the TimeTracker program reverts back to demo mode.    
Keep your Name and Registration code that Maui Software gave to you in a safe place in 
case you will need to enter the registration information again.



File Menu

The File Menu contains commands to create a new document, open an existing document 
and save an open document to a disk file.    The commands to export the document 
information into a tab delimited file, print a report of the information in the document, and 
exit the TimeTracker program are also available under the File Menu.
New

Use this command to create a new document in TimeTracker.    A new document window 
will be opened.    See Start a New Document for more information.

Open...
Use this command to open an existing document in a new window.    See Open an 
Existing Document for more information.

Close
Use this command to close the window containing the active document.    TimeTracker 
prompts you to save the document if it has unsaved changes.    Before closing an 
unnamed document, TimeTracker displays the Save As dialog box and suggests that you 
name and save the document.

Save
Use this command to save the active document with its current name and location.    
When you save a document for the first time, TimeTracker displays the Save As dialog 
box so you can name your document.    If you want to change the name or location of an 
existing document, choose the Save As command.    See Save a Document for more 
information.

Save As...
Use this command to save and name the active document.

Export...
Use this command to save the time entries of the active document to a tab delimited file.
See Export a Document for more information.

Print...



Use this command to print document reports.    See Print a Report for more information.
Print Preview

Use this command to switch the active document to and from print preview, with which 
you can see how the document report will look when you print it.    See Print a Report for 
more information.

Print Setup...
Use this command to select a printer and a printer connection.    The printer selected will 
be the printer designated as the selected printer when printing a report.

1, 2, 3, 4
Use the numbers and filenames listed at the bottom of the File menu to open the last 
four documents you closed.    Choose the number that corresponds with the document 
you want to open.

Exit
Use this command to end the TimeTracker program.    TimeTracker prompts you to save 
documents with unsaved changes.



Edit Menu

The Edit Menu contains the commands to Cut, Copy, Paste, Delete, Select All, and Select 
None.    The Cut and Copy commands will copy the highlighted rows from the Time Entry 
List Box to an internal buffer.    The buffer internal to TimeTracker will exist until the 
TimeTracker program is exited.    The Cut and Copy commands at the same time will also 
copy the highlighted rows to the Clipboard as tab delimited text.    This text is the same 
format of tab delimited text that is saved to a file using the Export feature.    The Select All 
and Select None command will highlight or UN-highlight all rows in the Time Entry List Box
Cut

The Cut command will delete the highlighted rows from the Time Entry List Box.    A copy 
of the highlighted rows information will be saved in an internal TimeTracker buffer.    This 
internal buffer will allow the user to paste the information into a TimeTracker document 
at a later time.    The highlighted rows information will also be saved as "tab" delimited 
text in the Clipboard.    This text is the same format of tab delimited text that is saved to 
a file using the Export feature.    The Cut command can also be activated by selecting the
Cut Button from the TimeTracker application Toolbar.

Copy
The Copy command will save a copy of the highlighted rows in the Time Entry List Box.    
The highlighted rows will be copied as "tab" delimited text to the Clipboard.    This text is 
the same format of tab delimited text that is saved to a file using the Export feature.    An
internal TimeTracker buffer will also hold a copy of the information in the highlighted 
rows.    This information held in the internal buffer will then available to be "Pasted" in the
Time Entry List Box.    This internal TimeTracker buffer is cleared when the TimeTracker 
program "Exits".    The Copy command can also be activated by selecting the Copy 
Button from the TimeTracker application Toolbar.

Paste
The Paste command will copy the internal TimeTracker buffer into the Time Entry List 
Box.    The new rows will be added to the end of the list box, but before an active Time 
Entry row.    Only highlighted rows that have been previously Cut or Copied from within 
TimeTracker can be Pasted.    The Paste command can also be activated by selecting the 
Paste Button from the TimeTracker application Toolbar.

Delete
The Delete command will delete the highlighted rows from the Time Entry List Box.    The 
rows deleted will NOT be put in the Clipboard or saved to the internal TimeTracker buffer. 
The Delete command can also be activated by selecting the Delete Button from the 
TimeTracker Document Window Toolbar.

Select All
The Select All command will highlight all rows in the Time Entry List Box.

Select None



The Select None command will UN-highlight all rows in the Time Entry List Box.



Time Menu

The Time Menu contains commands to edit a time entry, to set Document Preferences for 
the active document and to set General TimeTracker program preferences.

Edit Time Entry...
Use this command to display the Edit Time Entry dialog box.    The time entry that is 
highlighted in the active document will be available for editing in this dialog box.    The 
Edit Time Entry command can also be activated by selecting the Edit Time Button from 
the TimeTracker Document Window Toolbar.

Document Preferences...
Use this command to display the Document Preferences dialog box.    The preferences 
specific to the active document can be set here.    The document specific preferences 
include the hourly rate and time display options.    The Document Preferences command 
can also be activated by selecting the Document Preferences Button from the 
TimeTracker Document Window Toolbar.

General Preferences...
Use this command to display the General Preferences dialog box.    The auto-save, default
hourly rate and window compacting options can be set here.    The TimeTracker General 
Preferences command can also be activated by selecting the General Preferences Button 
from the TimeTracker Document Window Toolbar.



View Menu

You can display or hide parts of the screen to achieve the balance you want between 
graphical features and the size of the area this application uses on the screen.
Toolbar

Use this command to display and hide the Toolbar, which includes buttons for some of 
the most common commands in TimeTracker, including New, Open, Save, Cut, Copy, 
Paste, Print, Compact/Restore and Help.    A check mark appears next to the command 
name when the Toolbar is displayed.

Status Bar
Use this command to display and hide the Status Bar.    The Status Bar will display a 
description of selected menus and buttons.    A check mark appears next to the command
name when the Status Bar is displayed.



Window Menu

The Window Menu contains commands to manipulate the child window within the 
TimeTracker program window.    The Cascade, Tile - Horizontal, Tile - Vertical, Arrange Icons, 
1,2,3,4, are standard Multi-Document Interface commands.    The Compact Windows and 
Restore Windows commands are specific to the TimeTracker program.
Cascade

This command arranges TimeTracker document windows so that they overlap.    The title 
bar of each window remains visible, making it easy for you to select any window.

Tile - Horizontal
This command arranges TimeTracker document windows one above the other, so that 
each window is visible and none overlap.

Tile - Vertical
This command arranges TimeTracker document windows side by side, so that each 
window is visible and none overlap.

Arrange Icons
This command will arrange TimeTracker document windows that are reduced to icons, so 
that you can see them all.

Compact Windows
This command will minimize the TimeTracker document windows, arrange them in the 
upper left portion of the TimeTracker application window, and resize the TimeTracker 
application window to contain one row of document icons.    See Compact Screen Usage 
for more information.

Restore Windows
This command will restore the TimeTracker application window to the size and location 
when the Compact Windows command was executed.    See Compact Screen Usage for 
more information.

1, 2, 3, 4 
This command will make an opened TimeTracker document window active when you 
choose its name from this list.    All open TimeTracker document windows are listed, 
including those that have been reduced to icons.



Help Menu

Help Contents
Use this command to display the opening screen of TimeTracker in the Windows Help 
application.    From the opening screen, you can jump to specific instructions for using 
TimeTracker and to various types of reference information.    The Help command can be 
activated by selecting the Help Button from the TimeTracker Document Window Toolbar.   
The Help command can also be activated by selecting the Help Button from the 
TimeTracker application Toolbar.

About TimeTracker
Use this command to display the version number of this copy of TimeTracker for 
Windows.    The copyright notice and the person who this copy of TimeTracker is 
registered to is also displayed.



Set Hourly Rate
You can change the hourly rate for each specific document.    You can also change the 
default hourly rate that each new document will use.
Change Hourly Rate for a Specific Document
You change the hourly rate of the active document in the Set Hourly Rate dialog box.    The 
Set Hourly Rate dialog box is displayed by clicking the SET button on each document.    The 
hourly rate can be changed by selecting the Document Preferences... menu which is under 
the Time Menu.    The hourly rate can also be changed by selecting the Document 
Preferences Button from the TimeTracker Document Window Toolbar.    Type in the new 
hourly rate in the edit box and click on the OK button to change the hourly rate on the 
document specified.
NOTE:    All of the line costs for the active document will be recalculated using this new 
hourly rate.
Change Default Hourly Rate for New Documents
You change the default hourly rate for new documents in the General Preferences dialog 
box.    The General Preferences dialog box is displayed by selecting the General Preferences
menu from under the Time menu.    The General Preferences dialog box can also be 
displayed by selecting the General Preferences Button from the TimeTracker Document 
Window Toolbar.

Enter the hourly rate in the preferences dialog box to change the default hourly rate for new 
documents.



Auto Save Feature
The Auto-Save feature of TimeTracker will save the contents of a document every set 
number of minutes.    The Auto-Save feature is set in the General Preferences dialog box.    
The General Preferences dialog box is displayed by selecting the General Preferences menu
from under the Time menu.    The General Preferences dialog box can also be displayed by 
selecting the General Preferences Button from the TimeTracker Document Window Toolbar.

The auto-save feature is enabled when the Auto-Save check box is checked.    In the Minutes 
box, type how often (in minutes) you want TimeTracker to save your work.    
NOTE:    The Auto-Save feature will not save a NEW document until a name has been given 
to the document.



Start a New Document
You can start a new document by selecting the New Menu from under the File Menu.    You 
can also select the New button from the Toolbar to start a New document.    An empty 
document window inside the TimeTracker program window will be opened when a new 
document is started.



Open an Existing Document
You can open an existing document by selecting the Open Menu from under the File Menu.   
You can also select the Open button from the Toolbar to open an existing document.    The 
standard File-Open dialog box will be displayed to help you specify which file you want to 
open.    A document window with the requested file is displayed inside the TimeTracker 
program window when the file is opened.



Save a Document
You can save an open document by selecting the Save or Save As Menu from under the File 
Menu.    You can also select the Save button from the Toolbar to save an open document.    
The standard Save As dialog box is displayed when the Save As Menu is selected or the 
document being saved has not been assigned a file name.    Use the Save As dialog box to 
help you specify the name of the file to save the documents data into.



Print a Report
You can print a report containing the time entry information of a document.    You print a 
report by selecting the Print Menu from under the File Menu.    You can select the Print 
button from the TimeTracker application Toolbar to print the active document or select the 
Print Button from the TimeTracker Document Window Toolbar. The active document's 
information will be printed in the report.    The standard Print dialog box is displayed to aid 
in specifying printer information.    
You can preview the printed report by selecting the Print Preview Menu from under the File 
Menu.



Export a Document
The Export command is located under the File Menu.    The Export button is located in the 
Document Window Toolbar.    Use this Export menu or button to save the time entries of the
active document to a tab delimited file.    This tab delimited file can then be imported into 
almost every database, spreadsheet, and work processing program.    You can use these 
other programs to make customized reports, or import the TimeTracker exported data in a 
database or financial program for further processing.
The Export As dialog box is displayed when the Export menu or Export button is selected.    
The Export As dialog box is similar to the Save As dialog box.    Specify a file name in the 
dialog box and click on the OK button to save the active documents information in this file.  
The default file extension for exported data is '.txt'.
The Cut and Copy features will place the highlighted time entry records as tab delimited 
text in the Clipboard.    The time entry records tab delimited data is the same format that is 
saved to a file with the Export feature.    You can then paste this tab delimited text into a 
database or reporting program to format output for reports.



Time an Activity
START Timing
You time an activity by selecting the Start Button on a document or the Start menu on the 
documents control menu.    
PAUSE / RESUME Timing
You can pause and resume the timing of an activity by selecting the Pause Button or 
Resume Button on the document or the Pause Menu or Resume Menu on the documents 
control menu.    
STOP Timing
You can stop the timing of an activity on a document by selecting the Stop Button on a 
document or the Stop menu on the documents control menu.

The Start/Stop menu text toggles between the label of Start and Stop.    The Pause/Resume 
menu text toggles between the label of Pause and Resume.    The Start / Stop, and Pause / 
Resume buttons are located on the Document Window Toolbar.



Compact Screen Usage
Two menu commands, two buttons on the toolbars and some preferences are available to 
resize the TimeTracker windows.    These commands are available to have the TimeTracker 
program rearrange its windows quickly to take up the least amount of space on your 
screen.
There are two ways to minimize the size of the TimeTracker windows.    One way is to 
minimize all child Document windows at once.    The other way is to shrink the size of child 
Document windows individually.
Shrink Child Document Windows Individually

To Shrink or Restore the size of the child windows individually, click on the Compact/Restore
Button located on the Document Window Toolbar.    With the TimeTracker windows 
compacted, you can start, stop, pause and resume timing of your work and restore the size 
of the child window using the buttons on the Document Window Toolbar.

Minimize All Child Document Windows

With the TimeTracker windows compacted, you can start, stop, pause and resume timing of 
your work using the system menu of each iconized document window.    You popup the 
system menu for an icon by clicking on the document icon once.
Compact and Restore Menus
The two menus Compact and Restore. are located under the Window Menu.    

Compact Windows Menu    This command will minimize the TimeTracker document 
windows, arrange them in the upper left portion of the TimeTracker application window, 
and resize the TimeTracker application window to contain one row of document icons.
Restore Windows Menu    This command will restore the TimeTracker application 
window to the size and location when the Compact Windows command was executed.

Compact / Restore Application Toolbar Icon
This Compact / Restore Icon is located in theTimeTracker application Toolbar.    The Child 



Windows can be compacted or restored to original locations by clicking on this icon.
Compacting Preferences
You can set preferences for the compacting of the TimeTracker windows in the General 
Preferences dialog box.    The General Preferences dialog box is displayed by selecting the 
General Preferences Menu from under the Time Menu.    The General Preferences dialog box
can also be displayed by selecting the General Preferences Button from the TimeTracker 
Document Window Toolbar.

The two settings you can control for the compacting of the TimeTracker windows are 
whether the status bar or toolbar will automatically be hidden when the Compact Menu is 
selected.    These two settings can be changed in the General Preferences dialog box.



Display Time Feature
The Elapsed Time can be displayed in various formats and increments of time.    The 
Elapsed Time is displayed in the Elapsed Time area by the top of the document window, the
elapsed time column in the Time Entry List Box and the Total Elapsed time by the bottom of
the document window.    
The Elapsed Time Display preferences can be selected in the Set Document Preferences 
Dialog Box.    The time display preferences can be changed by selecting the Document 
Preferences... menu which is under the Time Menu.    The time display preferences can also 
be changed by selecting the Document Preferences Button from the TimeTracker Document
Window Toolbar.    See Set Document Preferences Dialog Box for more information on 
setting the time display preferences.

Time Display Increments
The exact number of seconds elapsed is saved for a time entry record.    The manner in 
which the time is rounded up and displayed on the screen or in reports is affected by the 
selections described here.    The Elapsed time can be displayed in increments of 1 second, 1
minute, 6 minutes, 15 minutes and 100th of an hour.    An example of how the time: one 
hour, 11 minutes and 34 seconds will be displayed in each.

1 second    The elapsed time is displayed down to the second.    This is the only selection
where the seconds are displayed.    The example time is displayed as:    01:12:34
1 minute    The elapsed time is displayed only in hours and minutes.    Any seconds will 
round up to the next minute.    The example time is displayed as:    01:13
6 minutes    The elapsed time is displayed in hours and minutes where the minutes are 
multiples of 6.    The minutes are rounded up to the next multiple of 6.    The example 
time is displayed as:    01:18 in the default format of hours : minutes and the time is 
displayed as:    01.30 in the decimal format.
15 minutes    The elapsed time is displayed in hours and minutes where the minutes are
multiples of 15.    The minutes are rounded up to the next multiple of 15.    The example 
time is displayed as:    01:15 in the default format of hours : minutes and the time is 
displayed as:    01.25 in the decimal format.
100th of an hour    In this time increment display, you select the number of 100th of an 
hour increments to display the elapsed time in.    The number entered in the text box can 
range from 5 - 100.    This number is only used when the 100th of an hour is selected.    
For instance, enter the number 50 to have the time displayed in increments of 30 
minutes (i.e.: 50/100 hour or 1/2 hour).    Another instance, enter the number 10 to have 
the time displayed in increments of 6 minutes (i.e.: 10/100 hour or 1/10 hour).    Another 
instance, enter the number 5 to have the time displayed in increments of 3 minutes (i.e.:
5/100 hour or 1/20 hour).    If the number 50 is entered in the text box, the example time 
is displayed as:    01:30 in the default format of hours : minutes and the time is displayed 
as:    01.50 in the decimal format.

Time Format
Default Format    The default format to display the time in is:



        hour : minute    or    hour : minute : second
Decimal Format    Time can also be displayed decimally in hours and hundredths of an 
hour.    For instance, using time display of 6 minute increments, one hour and 12 minutes 
will be displayed regularly as:    01:12 and in decimal notation the time would be 
displayed as:    01.20
Decimal format is not available for time display increments of 1 second and 1 minute.



Edit Time Entry
You can edit the information in any of the lines in the Time Entry list box.    You edit a line of 
Time Entry information in the Edit Time Entry dialog box.
There are several ways to bring up the Edit Time Entry dialog box with a line of time 
information to edit.    Double click on a time entry line to bring up the Edit Time Entry dialog
box with the selected line of information in it.    You can edit time entry records by selecting 
one or more lines in the Time Entry list box and then select the Edit Time Entry menu under
the Time Menu.    The Edit Time Entry command can also be activated by selecting the Edit 
Time Button from the TimeTracker Document Window Toolbar.
In the Edit Time Entry dialog box, you can edit the Start Date, Stop Date or Pause Time.    
Then click on the Recalculate button to see the new Elapsed Time calculated.    You cannot 
edit the Elapsed Time directly.    Type in comments information in the Notes edit window.    
Click on the OK button if you want to transfer this changed information back to the Time 
Entry list box.    Click on the Cancel button to disregard any changes made to the time entry
information in this dialog box.
See Edit Time Entry dialog box for more information on editing the time entry records.



Document System Menu
This is the documents System Menu.    It contains the usual document system menus, plus a
start/stop menu and pause/resume menu that mirror the start/stop and pause/resume 
buttons on the document.



Program Minimize / Maximize Buttons
The Programs Minimize and Maximize buttons will act on the entire TimeTracker program 
window.    The Minimize button will reduce the TimeTracker to an icon.    The Maximize 
button will make the TimeTracker program window as big as your screen can handle.



Program Title Bar
The TimeTracker Programs Title Bar will display the TimeTracker program name and the 
name of the active document window.



Program System Menu
The TimeTracker Programs System Menu is the standard program system menu.



Menu Bar
The TimeTracker Program Menu Bar contains the standard File, Edit, View, Window and Help
Menus.    For more information about the menus click on Menu Commands and the Help 
Table of Contents will be displayed with a list of menu commands to click on.    



Status Bar
The TimeTracker Status Bar contains the standard help messages for Menu selections.



Application Tool Bar
The TimeTracker Program ToolBar contains shortcut buttons to execute the standard File-
New, File-Open, File-Save, Edit-Cut, Edit-Copy, Edit-Paste, File-Print and Compact/Restore 
Child-Windows and Help commands.



Document Tool Bar
The Document ToolBar contains shortcut buttons to execute the following commands:    

 Compact/Restore Child-Windows,

    Start    

 Stop Timing,

 Pause    

 Resume Timing,

 Edit Time Entry,

 Print,

 Export,

 Edit General Preferences,

 Edit Document Preferences,

 Delete Time Entry and

 Help.
The prompts for these toolbar buttons appear in the status bar when the buttons are 
depressed.    The prompts for the toolbar buttons can be shown and the toolbar buttons not 
executed if the cursor is off the toolbar button before the mouse button is released.



Document Minimize / Maximize Buttons
The document Minimize and Maximize buttons will control that documents window size.    
The Minimize button will reduce the document window to an icon at the bottom of the 
TimeTracker window.    The Maximize button will make the document window as big as will 
fit inside of the TimeTracker program window.



Document Title Bar
Every TimeTracker document window has a title bar that displays the name of the file that 
holds that documents information.



Notes
This column holds some notes about this time entry line.    The notes are entered or 
changed in the Edit Time Entry dialog box.



Charge
This column displays the amount of charge calculated for the duration in this time entry 
line.    The charge is calculated by multiplying the Elapsed Time by the Hourly Rate.



Elapsed Time
This column holds the elapsed time for the time entry.    The time can be displayed in 
increments of seconds, minutes, 6 minute, 15 minute and 100th of an hour intervals.



Stop Time
This column holds the time that the time entry was stopped.    The time is displayed in 
Hour:Minute and AM or PM.



Start Time
This column holds the time that the time entry was started.    The time is displayed in 
Hour:Minute and AM or PM.



Date
This column holds the date that the time entry was started.    The date is displayed in 
Month/Day/Year format.



Time Entry List Box
This List box contains lines of Time Entry information.    Each line contains the start and stop
time with the duration, charge and notes.    You can edit the information in a line from 
within the Edit Time Entry dialog box.



Total Charge
The Total Charge is shown in the Grand Totals box at the bottom of the Charge column.    
This total is the sum of all of the 'Charge' entries of every line in this document.



Pause / Resume Button
The Pause / Resume button will pause or resume the timer for the current active time entry. 
Clicking on the Pause button will pause the timer for the current active time entry.    Clicking
on the Resume button will resume the timer for the current active time entry.



Hourly Rate
The hourly rate displayed here is the hourly rate used by this document.    Every document 
window can have a different rate.    All of the time entries of a document will use this rate to
calculate the Charge.    You can change the hourly rate used by this document by clicking 
on the Set button.



Total Elapsed Time
The Total Elapsed Time is shown in the Grand Totals box at the bottom of the elapsed Time 
column.    This total is the sum of all of the elapsed time entries of every line in this 
document.



Start / Stop Button
The Start / Stop button will start or stop the timer.    Clicking on the Start button will start 
the timer and show a new time entry line in the Time Entry List Box.    Clicking on the Stop 
button will stop the timer on the current time entry in the Time Entry List Box.



Elapsed Time
The Elapsed window shows the time of the current active time entry.    The time can be 
displayed in increments of seconds, minutes, 6 minute, 15 minute and 100th of an hour 
intervals.



TimeTracker Main Window
TimeTracker Main Window is the usual Windows Multi-Document Application.    The Main 
Window has a title bar, menu bar, tool bar, status bar.    The TimeTracker can have multiple 
files open.    Each file will be opened in its own child window which always resides inside of 
the TimeTracker application.    The following bitmap has 'hot spots' on it so that you can 
click on an area of the bitmap to popup a window of more information about a particular 
area of the TimeTracker window.

The prompts for the toolbar buttons appear in the status bar when a button is depressed.    
The prompts for the toolbar buttons can be shown and the toolbar buttons not executed if 
the cursor is moved off the toolbar button before the mouse button is released.



Set Hourly Rate Dialog Box
Use this dialog box to change the hourly rate for an individual document.    This dialog box 
can be displayed by selecting the SET button in a document window.    The hourly rate can 
be changed by selecting the Document Preferences... menu which is under the Time Menu. 
The hourly rate can also be changed by selecting the Document Preferences Button from 
the TimeTracker Document Window Toolbar.

Document Name    The name of the document that will receive this change in hourly rate 
is displayed in the dialog.    In the above example, the document name is TimeT1.
Hourly Rate    Enter the new hourly rate to be used in the specified document.
Select the OK button to change the hourly rate on the document.    Select the Cancel 
button to leave the hourly rate unchanged.



Set Document Preferences Dialog Box
The Document Preferences Dialog Box is displayed by selecting the Document Preferences 
menu under the Time menu.    The Document Preferences Dialog Box can also be displayed 
by selecting the Document Preferences Button from the TimeTracker Document Window 
Toolbar.    The active documents Hourly Rate and Time Display feature settings can be 
altered using this dialog box.

Name of the Active Document    The name of the active document is displayed at the 
top of this dialog box.    The changes made in this dialog box will apply only to this 
document.
Active Document Hourly Rate Preference    Enter the hourly rate here to change the 
hourly rate for the active document.    The hourly rate entered will be used to calculate the 
Total Charges for this document.    The hourly rate entered here will be displayed in the 
"Hourly Rate" box at the bottom of the active document.
Active Document Time Display Preference    Select the time increment to display the 
elapsed time of the active document.    The elapsed time can be displayed in increments of 
seconds, minutes, or multiples of 6 minutes, 15 minutes or hundredths of an hour.    The 
time increments of 6 and 15 minute intervals, and hundredths of an hour can be displayed 
in Hour:Minute or in decimal notation.    The "use decimal notation" is grayed out when 1 
minute or 1 second intervals are selected.    The edit box next to the "100th of an hour" is 
grayed out when "100th of an hour" is not selected.    See the Time Display Feature for 
more information.
Select the OK button to save any changes in the preferences.    Select the Cancel button to
disregard any changes in the preferences.



Set General Preferences Dialog Box
The General Preferences Dialog Box is displayed by selecting the General Preferences menu
under the Time menu.    The General Preferences dialog box can also be displayed by 
selecting the General Preferences Button from the TimeTracker Document Window Toolbar.   
The Auto-Save feature, default hourly rate, and compacting settings can be altered using 
this dialog box.

Auto Save Preference    The auto-save feature is enabled when the Auto-Save check box 
is checked.    In the Minutes box, type how often (in minutes) you want TimeTracker to save 
your work.    
Default Hourly Rate Preference    Enter the hourly rate in the preferences dialog box to 
change the default hourly rate for new documents.
Compact Windows Preference    The two settings you can control for the compacting of 
the TimeTracker windows are whether the status bar or toolbar will automatically be hidden
when the Compact Menu is selected.    The x'd status bar check box means that the status 
bar will be hidden when the Compact Menu is selected.    The x'd ToolBar check box means 
that the ToolBar will be hidden when the Compact Menu is selected.
Select the OK button to save any changes in the preferences.    Select the Cancel button to
disregard any changes in the preferences.



Edit Time Entry Dialog Box
The Edit Time Entry dialog box provides the mechanism to edit the information in any of 
the lines in the Time Entry list box.
There are several ways to bring up the Edit Time Entry dialog box with a line of time 
information to edit.    Double click on a time entry line to bring up the Edit Time Entry dialog
box with the selected line of information in it.    You can edit time entry records by selecting 
one or more lines in the Time Entry list box and then select the Edit Time Entry menu under
the Time Menu.    The Edit Time Entry command can also be activated by selecting the Edit 
Time Button from the TimeTracker Document Window Toolbar.

In the Edit Time Entry dialog box, you can edit the Start Date, Stop Date or Pause Time.    
Then click on the Recalculate button to see the new Elapsed Time calculated.    You cannot 
edit the Elapsed Time directly.    Type in comments information in the Notes edit window.
Start Date    The Start Date specifies the beginning of a time period.    The specification is 
in Month / Day / Year and Hour : Minute and AM/PM.    If you make changes to the Start Date
and want to see the changes reflected in the Elapsed Time, click on the Recalculate button.
Stop Date    The Stop Date specifies the end of a time period.    The specification is in 
Month / Day / Year and Hour : Minute and AM/PM.    If you make changes to the Stop Date 
and want to see the changes reflected in the Elapsed Time, click on the Recalculate button.
Paused Time    The Paused Time specifies the total amount of time to exclude from 
between the Start and Stop Date.    The Paused Time is specified in Hour : Minute : Second.   
This time is originally generated by the total accumulated time the Pause button has been 
selected.    If you make changes to the Paused Time and want to see the changes reflected 
in the Elapsed Time, click on the Recalculate button.
Elapsed Time    The Elapsed Time is the total amount of time between the Start and Stop 
Time, but subtracting out the Paused Time.    The Elapsed Time is specified in Hour : 
Minute : Second.    The Elapsed Time is calculated using the Stop, Start and Paused Time 
when the Recalculate button is selected.    The Elapsed Time is also recalculated when you 
select the OK button.
Notes    A textual note can be added to each time period line.    The total number of 
characters allowed in the note is 255.    The accumulated number of characters entered in 
the Note edit box is shown under the Notes.    The Notes edit box will automatically wrap 
the text.    You can enter 'Carriage Returns' in the Notes edit box to force new lines.
Click on the OK button if you want to transfer this changed information back to the Time 
Entry list box.    If more time entry records were highlighted to be edited, the next record is 
displayed in the dialog box.



Click on the Cancel button to disregard any changes made to the time entry information in 
this dialog box.    If more time entry records were highlighted to be edited, the next record 
is displayed in the dialog box.
Click on the Cancel All button to disregard any changes made to the time entry 
information in this dialog box.    The Edit Time Entry dialog box is dismissed even if more 
time entry records were highlighted to be edited.


















































































